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1 Introduction 

1.1 Introduction to EasiShare 
EasiShare is a file sharing tool that allows user to share their files across different devices securely and 
to other users. Documents are stored in a server and readily accessible to its owner and their 
recipients who have been shared the document. Shared documents have an expiry timer when after a 
certain period of the time; the access rights are automatically revoked. 

 

1.2 EasiShare Desktop 
The EasiShare Desktop allows users of EasiShare to manage storage, file, and create Upload Request in 
a Desktop Explorer. Users will be able to perform create new folder, upload file, download file, modify 
existing file, create an upload request and more. Most of these functions performed will be directly 
take effect in Storage. 
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2 Login 

 Getting Started 
To login: 

1. Launch EasiShare program. 
2. Click on File and click Settings. 

 

3. At the Login section, enter your URL, username and password. 
4. Assume, if EasiShare URL need to connect using Proxy then enter Proxy details. If not, this is 

optional for user. 
5. Assume if EasiShare is configured as SSO, then skip step 2 and select “Use Single Sign On” 

checkbox. 
6. Click Save to proceed. 

1 
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Login Errors: 

If you encounter any error message below, 

1. Username entered does not exist. Check that you have entered a correct 
username. 

 
2. Invalid password entered. Check that you have entered a correct password. 

  
3. Your account has been disabled. Check with your Administrator. 

   
4. Your account is locked. Check with your Administrator. 

  
5.  Your must change your password before login. 
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 Accessing EasiShare 
 

1. Logging in will direct you to the page as shown below. You should see drive(s) that you can 
access. 

 

 

2. On this Home tab, you can navigate or access to a drive located in the Drive List on left 
panel while the common functionalities for every item are at the top panel. 

 
 

Drive Content 

Drive List 

Common Functionalities 

 

Refresh 

 

Search 

Files & Folders shared by EasiShare users to you. 

Personal/Share Drives dedicated that you have 
permission to access. 

Files & Folders that you’ve shared out. You may 
want to review, revoke or extend the share here. 

After you have initiated file upload request to non-
EasiShare account users and they have uploaded 
the files, you can download from here. 

Shared Drives/Folders that have been given 
permission to you by other EasiShare users to 
collaborate. See where the owner has used the 
“Manage” function. 
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3. When you click on the Share tab, you can Share files/folders, Request files and Generate the 
Link for the selected files/folders. 
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 Switching Views 

1. If the user clicks on the List view icon  , the display will change to List view. 
2. Three Sizes of choice are given, from left to right, small, medium, and large views. 

 

3. User will be able to Sort according to their preference with the help of sorting menu. 

 Concurrent Login 
1. Assume that the administrator has enabled concurrent login, you would be able to login to 

multiple desktops using the same user account. 
 

2. Assume that administrator has disabled concurrent login, you would only be able to access 
your user account in one desktop at a time. 

 Whenever the system detects concurrent access, it will display below message to sign 
out from previous devices before proceeding to login in the current device. 

3 
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 For the other devices, the same user account would be automatically signed out.  If 

you would like to continue usage, you would be required to login again. 

3 Folder Operations 

 Create a New Folder 

1. Click on a storage located in the Drive List along the left panel to navigate to the new folder’s 
location. 

2. Click on New Folder along the Home Tab located at the top. 
3. Enter folder name in the input box. 
4. Press Enter. 

 

 

 

 

 

 

2 

3 
1 



 

 
EasiShare Desktop User Guide V10.3.0 

 

 

 

© Copyright 2021 Inspire-Tech Pte Ltd. All Rights Reserved. Page 13 of 84 

 

 Rename a Folder 

1. Select the folder. To select, click on the white checkbox beside the folder name. 
2. Click on Rename along the Home Tab located at the top. 

 

3. Enter new folder name. 
4. Press Enter. 
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4 Upload Files 

 Using Upload Feature 

1. Click on Upload File. 

 

2. Select the file/folder you wish to upload. You may select multiple files/folders at a time. 
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 Using “Drag & Drop” Method 

1. Drag and drop file/folder from your PC file explorer to EasiShare explorer. You may select 
multiple files/folders at a time. 

 

 

 Check Upload Status 

1. A status bar will pop-up and show the progress of the activity. 
2. Click on File Activity icon located at the top of the application. 
3. Alternatively, you can click on My Activity, it displays your action history. 
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4. Whereas in Sync History, it will display the sync upload from the user. 

 

 Uploading a Virus File 
 

When a Virus file is being uploaded directly or to the sync folders in File Explorer, the following 
steps below will take place: 

1. The error message below will be displayed in EasiShare: 

2 

3 
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2. An email notification regarding virus detection will be sent to the User: 

Note: 
This scenario only applies if customer has implemented Virus scanning in EasiShare. If not turn on, then 
ignore this scenario. 

 

5 File Operations 

 Copy/Move 

1. Select the file/folder. To select, click on the checkbox beside the file/folder name. You may 
select multiple files/folders at a time by clicking on multiple checkboxes. 

2. Click on Copy along the Home Tab located at the top. 
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3. Select the drive/folder you want to move your file(s)/folder(s) to. 
4. Paste the file(s)/folder(s) at the selected location. 

 

 

  

Note: Moving a file/folder that is shared may cause the link to break. Recipients may not be 
able to access such file/folder. The user can also use shortcut keys like Ctrl + C to copy, Ctrl 
+ X to cut and Ctrl + V to paste the file. 
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 Download 

1. Select the file/folder. To select, click on the checkbox beside the file/folder name. You may 
select multiple files/folders at a time by clicking on multiple checkboxes. 

2. Click on Download To along the Home Tab located at the top. Alternatively, you can click on 
the file(s)/folder(s) name. 

 

 

  

2 

1 



 

 
EasiShare Desktop User Guide V10.3.0 

 

 

 

© Copyright 2021 Inspire-Tech Pte Ltd. All Rights Reserved. Page 20 of 84 

 

 Delete 

1. Select the file/folder. To select, click on the checkbox beside the file/folder name. You may 
select multiple files/folders at a time by clicking on multiple checkboxes. 

2. Click on Delete along the Home Tab at the top panel. 
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 Copy path 

1. Select the file/folder. To select, click on the checkbox beside the file/folder name. You may 
select multiple files/folders at a time by clicking on multiple checkboxes. 

2. Click on Copy path along the Home Tab at the top panel. 

 

3. User can proceed to paste this path link into his/her email and send it to internal collaborators 
for easy access. 

 

 

1 

2 

3 



 

 
EasiShare Desktop User Guide V10.3.0 

 

 

 

© Copyright 2021 Inspire-Tech Pte Ltd. All Rights Reserved. Page 22 of 84 

 

 Send as Link 

1. Select the file/folder. To select, click on the checkbox beside the file/folder name. You may 
select multiple files/folders at a time by clicking on multiple checkboxes. 

2. Right-click on the file. Go to ‘Share’ and click ‘Send as Link’. 

 

3. The user will be automatically directed to Outlook, with the file links generated. User can 
proceed to send this link via email to other internal users only. 
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 Recycle Bin 

The following features are available when you click the Recycle Bin Icon of a drive and select 
file(s)/folder(s): 

 Download To 
1. Users can proceed to download the deleted file(s)/folder(s) in his Recycle Bin in Local 

Drive/PC by clicking  icon. 
2. The pop-up below would be displayed for the user to select the storage area to save the 

document: 

 
 Restore  

1. Users can restore deleted items from his Recycle Bin to the original storage drive of the 

document by clicking  icon. 
2. The file(s)/folder(s) will be restored in the original drive. 

 
 Delete 

1. The user can delete the items permanently from his Recycle Bin to the original storage 

drive of the document by clicking  icon. 
2. The pop-up below would be displayed for the user to confirm the deletion process. 
3. If click ‘No’, the action will be cancelled, and the file will stay in the Recycle Bin. 

If click ‘Yes’, the file will be removed permanently from the server. 
(Note:  
A copy will be reserved in the Admin’s Recycle Bin if customer has Admin Recycle Bin feature 
turned on.) 
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 Preview 

1. Navigate to the folder where the file resides. 
2. Select the file. To select, click on the checkbox beside the file name. 

3. Select the Preview  along the Action Pane located at the top. 
 

 
 
 
A pop-up box will appear with the preview of the file. 
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 Preview a File with Viewer Permissions 

1. Navigate to the folder where the file resides. 
2. Select the file. To select, click on the file name. 

3. Select the Preview  along the Action Pane located at the top. 
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A pop-up box will appear with the preview of the file. 

 

Note: Users with Viewer permissions previewing a file will have a watermark displaying the 
user’s name and email address. 
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 Document Tag 
Note: The Document Tag function allows users to select and tag files. These tags may have 
sharing restrictions enforced by your administrator. 

1. Navigate to the folder where the file resides. 
2. Select the file. To select, click on the checkbox beside the file name. 

3. Select the Document Tag  along the Action Pane located at the top. 

 

4. Select the tags for this file. 
5. Click on Apply to All and the file will be tagged with the chosen tags. 
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6 Share  

 

Scenarios & How to use the functions 

Scenarios What do you (the initiator) 
do? 

What do the recipient do? 

 

I want to send documents to 
my vendor to download. 

 

Select doc & click on “Share” 

 

Click on the link & download 
the file(s). 

 

I want to send a set of files to 
my vendor to download. 

Either 

1) Put them in a folder, 
select the folder & click 
on “Share” 

2) Multi-select the files & 
click “Share” 

 

Click on the link from the email 
& download the files in a 
zipped folder. 

 

I want to collaborate with my 
colleagues to allow them to 
contribute files for a project. 
Both my colleagues and 
myself can upload and delete 
files in the same folder. 

 

Select a folder & click on 
“Manage” 

Set the permission as author 
for the colleagues. 

 

Login as user & click on Shared 
Drives with a different icon. 

e.g.  

 

Initiator 

EasiShare Users/Groups 

Non-EasiShare Users 

Manage 

  

Share 

to perform one-way 
sharing of files/folders for 
recipient to download 

View/Upload files in 

Download files in 

Edit/Revoke Share Out 

Click on Email 
link to view &  
download files 



 

 
EasiShare Desktop User Guide V10.3.0 

 

 

 

© Copyright 2021 Inspire-Tech Pte Ltd. All Rights Reserved. Page 30 of 84 

 

 Share 

 

1. Select the file/folder you wish to share. You may select multiple files/folders. 
2. Click on Share along the Share Tab located at the top. 

 

3. Enter the recipient’s name, email and/or contact number. Contact number is only mandatory 
if you wish to enable One Time Password (OTP). Otherwise, you may leave it blank. 

Tips: The username that appears with a star is an internal user. 

4. Click on  to confirm recipient. Alternatively, you can press enter. 
Tips: After adding the recipient, the name and mobile number can still be edited by clicking 
on the respective fields. 

Note: Share function allows users to share file/folder to allow recipients to view or download 
and receive a copy of the file/folder(s). Any changes made to the file/folder(s) by the recipients 
will not affect the sender’s original copy. 

If you wish to collaborate with internal users, please use the Manage function. For a detailed 
guide, do refer to “Section 7” of this user guide. 

1 
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5. To import multiple recipients, click on Manage Recipient   on the top right 
corner, click on Import Recipient List to browse for a CSV file to import a list of recipients 
with the headers Name, Email and Mobile. 

6. You can also export an empty template by clicking on Manage Recipient  
on the top right corner, click on Export Recipient List for exporting a list of recipients’ details 
that are added individually. 

7. If you wish to create a group, add 2 or more recipients, click on Manage Recipient on the top 
right corner, then click on Create Group. 

8. Enter your message. 
9. Enable/Disable settings you wish to apply. To find out in details how each feature works, refer 

to the respective sections below. 
10. Click on the checkbox to agree to our Terms and Conditions. 
11. Click Share. 

 

6.1.1 Share to User Groups 

1. Select the file/folder you wish to share. You may select multiple files/folders. 
2. Click on Share along the Share Tab located at the top. 
3. Enter the User Group name on the Name field and select the User Group(s) to share. 

3 

3 4 
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Tips: After adding the user group, the members of the user group can be displayed by 
clicking on the “show/hide members”. 
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4. Enter your message. 
5. Enable/Disable settings you wish to apply. To find out in details how each feature works, refer 

to the respective sections below. 
6. You must check this checkbox to agree to the terms and conditions. 
7. Click Share. 

 

6.1.2 Share with Download Permission 

1. Refer to step 1 to 9 of Section 6.1 to begin sharing. 
2. Ensure below option ‘Share with View Only’ was not selected. 
3. You must check this checkbox to agree to the terms and conditions. 
4. Click Share. 

 

 

6.1.3  Share with ‘View Only’ Permission 

1. Refer to step 1 to 9 of Section 6.1 to begin sharing. 
2. Ensure below option ‘Share with View Only’ was selected. 
3. You must check this checkbox to agree to the terms and conditions. 
4. Click Share. 
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6.1.4 Share with Link Expiry 

1. Refer to step 1 to 9 of Section 6.1 to begin sharing. 
2. Ensure below option ‘Link Expires’ selected and choose the date for link expiry. 
3. You must check this checkbox to agree to the terms and conditions. 
4. Click Share. 

 

 

6.1.5 Share with One Time Password (OTP) 
Users normally turn on OTP if Share link want to be more secure. End recipients only can be 
downloaded when they enter a valid OTP. 

1. Refer to step 1 to 9 of Section 6.1 to begin sharing. 
2. Select ‘OTP’ Option. 
3. You must check this checkbox to agree to the terms and conditions. 
4. Click Share. 

2 
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6.1.6 Share and Receive Notifications When Users Accessed the File/Folder(s) 
 
Users normally turn this on if you are eager to know immediately when the recipient has 
downloaded/viewed the file. If this option is turned on and the recipient download/view the file more 
than once, user will also receive the same number of notifications. 

However, if this option is not turned on, the system will still send a summary of all the different 
downloads by at certain time interval. 

1. Refer to step 1 to 9 of Section 6.1 to begin sharing. 
2. Select ‘OTP’ Option. 
3. You must check this checkbox to agree to the terms and conditions. 
4. Click Share. 
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6.1.7 Share with Number of Download Attempts 

Enable the number of attempts allow the user to limit the number of download the recipient can 
download the file. This option can be set as default in the policy; however, the user will not be able to 
enable/disable this option nor changing the numbers of attempts as the policy is set. After the 
recipient downloads reaches the limit, the recipient will not be able to download the file. 

1. Refer to step 1 to 9 of Section 6.1 to begin sharing. 
2. Enable No. of attempts. 
3. Fill in the number of attempts the user can download the file. 
4. You must check this checkbox to agree to the terms and conditions. 
5. Click Share. 

 

 

 Access Shared Files/Folders 

6.2.1 Email Notifications 

1. To access file/folder(s) shared to you, you can click on the link given via the email notification. 

2 

3 
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Note: For external recipients, they will only be able to view or download the specific file(s) or 
folder(s) that you have shared. 

 

Note: For internal recipients, they will only be able to view or download the specific file(s) or 
folder(s) that you have shared. 
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6.2.2 Shared In 

1. To access file/folder(s) shared by another to internal user to you, click on Shared In located 
along the left panel. 

 

 

6.2.3 Shared Out 

1. To access file/folder(s) that have been shared out one-way by you to internal/external users. 
2. Click on Shared Out located along the left panel. 

 

Note: Internal users refer to users who have a registered account in EasiShare. 

John smith 

Jane doe 

Jackson doe 
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 Edit/Remove Share 
There are two ways to edit share. Edits can be made at the file’s original location. Alternatively, you 
may choose to locate the file by the user’s email you have shared the file to in the “Shared Out” drive. 

6.3.1 Edit from File’s Original Location 

1. Select the file/folder. 
2. Click on Edit Share at the top panel. 

 

 

  

Note: External users refer to users who do not have a registered account in EasiShare. 
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3. If you wish to change the link expiry date/time or turn off the notification for specific 
recipients, select the recipient you wish to apply changes to by clicking on the white space 
beside the recipients’ name. 

4. Apply the changes by enabling/disabling the features or changing the date and time of the 
link expiry. To find out in details how each feature works, refer to the respective sections 
above. 

5. Click Update Share to confirm your actions. 
 

 
 

6. If you wish to resend the email for a recipient, click on and the email will be sent 
immediately. 

7. If you wish to remove a recipient, click on and click on Update Share to confirm your 
decision. 

 

 
 

Note: 

1. Modifications to the settings will only be applied to the user you have selected. 

2. Some features may be controlled by your central administrator. If you are unable to enable or 
disable, it may be due to your organisation policy settings. 
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6.3.2 Edit from Shared Out Folder 

1. Click on Shared Out along the left panel . Select the user’s name. 
2. Select the file you wish to edit. 
3. Click on Edit Share at the top panel. 
4.  A similar edit share pop-up window will appear. You may refer to Edit from file’s original 

location to find out how to edit, resend email or remove share. 
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7  Manage Folder to Collaborate with Internal Users 

 Manage Folder for Collaboration to Users/User Groups 

1. Navigate to the folder you wish to collaborate with other users. Select the folder. 
2. Click on Manage along the Action Pane located at the top panel. 

 

3. Enter the User/User Groups name. 
4. Assign the permission type you wish to give to the User/Group. 
5. If you wish to copy permissions that has already been set for another folder, select the folder 

name from the dropdown list and click on the copy icon . 
6. Check the box to enable/disable folder expiry if you wish to set an expiry for the folder. 
7. Check the box to enable/disable quota if you wish to limit the folder size. 
8. Click Apply. 
9. When the permission has been granted, the user will receive an email notification. 
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Note:  

1. If the folder expiry is enabled and auto-delete is selected, after the folder expires and a pre-
defined number of days set by your central administrator, the folder will be automatically 
purged by the system. 

2. Some features may be controlled by your central administration system. If you are unable 
to enable or disable, it may be due to your organisation policy settings. 

 Collaboration Permission Types 
Permission Type Description 

Reader Permission to read files 

Contributor  Permission to read, download, add and edit files 

Author Permission to read, download, add, edit and delete files  

Owner Permission to read, download, add, edit, delete and share files  

 

To view the drive permission given to the drive, you can hover to the drive and check the permission. 
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 Access Shared Drive 

1. A Shared Drive is a folder shared to you for collaboration among internal users. It is labelled 

with a different icon . 
2. You may access the Shared Drive by clicking on it. 
3. Once your permission has been revoked, you cannot see the folders under the Shared Drives 

anymore. 

 



 

 
EasiShare Desktop User Guide V10.3.0 

 

 

 

© Copyright 2021 Inspire-Tech Pte Ltd. All Rights Reserved. Page 45 of 84 

 

 

 

 Remove Access from Shared Drive 
If you no longer require the access to the shared drive, you can remove it from the drive list. 

1. Right click the Shared Drive that you wish to remove. 
2. Click on Remove My Access. 
3. Click Yes. 

 

  

Note: Internal users refer to users who have a registered account in EasiShare. 
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8  File Request to Receive Files from External Users 

 File Request 

1. Select File Request at the drive list located below “Shared Out”. 
2. Select New File Request at the Action Pane along the top panel. 

 

3. Enter the title of the file request. 
4. Enter the recipient’s name, email and/or contact number. Contact number is only mandatory 

if you wish to enable One Time Password (OTP). Otherwise, you may leave it blank. 

5. Click on  to confirm recipient. Alternatively, you can press enter. 

6. To import multiple recipients, click on   , and then click on Import Recipient 
List to browse for a CSV file to import a list of recipients with the headers Name, Email and 
Mobile. 

7. You can also export an empty template by clicking , and then click on 
Export Recipient List or use it for exporting a list of recipients’ details that are added 
individually. 

8. Enter your message. 
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9. Enable/Disable settings you wish to apply. To find out in details how each feature works, refer 
to the respective sections below. 

10. Click Send Request. 

 

 

 

File Request with Link Expiry 

File request with OTP 

 

Receive Notification When External Users Upload Files 

Restrict Number of Upload Attempts 

Restrict File Type 

Limit File Upload Size 

 

 
Note: Some features may be controlled by your central administration system. If you are unable 
to enable or disable, it may be due to your organisation policy settings. 
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8.1.1 File Request with Link Expiry 

1. Refer to step 1 to 10 of Section 8.1 File Request. 
2. Check the box to enable Link Expiry. Set the date and time by clicking on the calendar icon. 
3. Click Send Request. 

 

 

  

Note:  

1. After the folder expires and a pre-defined number of days set by your central 
administrator, the folder will be automatically purged by the system. 

2. Some features may be controlled by your central administrator. If you are unable to 
enable or disable, it may be due to your organisation policy settings. 
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8.1.2 File request with OTP 

1. Refer to step 1 to 10 of Section 8.1 File Request. 
2. Check the box at the top right corner of the pop-up window to enable OTP. 
3. Set the date and time of expiry. 
4. Click Send Request. 

 

 

 

 

  

Note:  

1. To enable OTP, contact number field is mandatory. 
2. This feature may be controlled by your central administrator. If you are unable to enable 

or disable, it may be due to your organisation policy settings. 

 

 

 

2 

3 

4 



 

 
EasiShare Desktop User Guide V10.3.0 

 

 

 

© Copyright 2021 Inspire-Tech Pte Ltd. All Rights Reserved. Page 50 of 84 

 

8.1.3 Receive Notification When External Users Upload Files 

1. Refer to step 1 to 10 of Section 8.1 File Request. 
2. Check the box to enable Notifications. 

Per Upload: An email will be sent to your inbox whenever a file is uploaded. 
Summary: An email will be sent to your inbox at regular intervals to inform you of all uploads 
which occurred in the past time period. 

3. Click Send Request. 
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8.1.4 Restrict Number of Upload Attempts 

1. Refer to step 1 to 10 of Section 8.1 File Request. 
2. Navigate to the next page by clicking on the panel on the right of the pop-out window. 
3. Check the box to enable No. of attempts. 
4. Specify the number of attempts you wish to limit. 
5. Click Send Request. 

 

 

  

Note: This feature may be controlled by your central administrator. If you are unable to 
enable or disable, it may be due to your organisation policy settings. 
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8.1.5 Restrict File Types 

1. Refer to step 1 to 10 of Section 8.1 File Request. 
2. Navigate to the next page by clicking on the panel on the right of the pop-up window. 
3. Select either allow all except or block all except for File Type Restrictions. 
4. Specify the file types you wish to allow or block. 
5. Click Send Request. 

 

 

  

Note: This feature may be controlled by your central administrator. If you are unable to 
enable or disable, it may be due to your organisation policy settings. 
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8.1.6 Limit File Upload Size 

1. Refer to step 1 to 10 of Section 8.1 File Request. 
2. Navigate to the next page by clicking on the panel on the right of the pop-up window. 
3. Check the box to enable File size limit. 
4. Specify the file size limit and select either MB or GB. 
5. Click Send Request. 

 

 

  

Note: This feature may be controlled by your central administrator. If you are unable to 
enable or disable, it may be due to your organisation policy settings. 
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 Upload Files Using File Request 

1. The recipient will receive an email notification. 
2. Click on the link provided. 

 

3. The recipient will be directed to the upload page. 
4. Click on Upload File or simply drag and drop the files into the empty area. 
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 Access Uploaded Files on File Request 

1. Click on the Personal drive. 
2. Click on File Request at left panel. 
3. Click on the title of the file request you wish to access. 
4. Click on the file name to download or select the file to perform other file operations. 
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 Edit File Request 
 

1. Select File Request drive. 
2. Choose an active File Request to edit. 

3. Click Edit File Request  located at the top. 
4. A window will appear, follow the steps in each bubble for each intended purpose. 
5. Click on the Update button. 

 

  

To resend email 
Click to resend 
email to guest user 
 

 

To remove one of the 
guest user 
1.  Click on delete icon 
2. Click on Update button 
to remove one of the 
guest user 

To change expiry date/time 
1. Select the expiry date/time 
2. Click on Update to update the 
expiry date/time & the guest user will 
receive an email again 
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 Revoke File Request 
1. Select File Request drive. 
2. Select an active File Request to revoke. 

3. Click Revoke File Request located at the top. 
4. A window will appear, click OK to confirm File Request Revoke. 

 

 

 

9 Check In/Out 
When working in a shared environment, overwriting files can create challenges among users. To 
prevent files to be accidentally overwritten, users can initiate a check out first before editing the file. 
Once the file has been updated, user can upload the new version and check in. After the file has been 
checked in, other user can use the updated version to continue their editing. 

 

 Auto Check Out a File 

1. Select the file you wish to check out and double click on it. 
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2. An edit icon will appear on the file icon on the user’s PC. 

 

3. While a lock icon will appear on the file icon on another users’ PC. 
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4. Hover over the file name to find the name of the user who checked out the file. 

 Manual Check Out a File 

1. Select the file you wish to check out. 
2. Click on Check Out located at the top panel. 

 

3. An edit icon will appear on the file icon. 
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4. Hover over the file name to find out who checked out the file. 

 

A new version will be created temporarily. This version is only visible to the user who checked out. 
Other users will only see the change in version after you have checked in. 
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5. You can choose to perform any file actions. All actions are available to the user who checked 
out. Other users will be able to perform some actions only. 

 

 

 Check In a File 

1. Select the file that was checked out. 
2. Click on Check In located at the top panel. 

 

3. A pop-up window will appear. You may choose to retain check out after checking in and enter 
comments. Click Check In. 

4. The edit icon on the file will disappear. 

Note: Other users will be restricted from performing certain file operations such as delete, rename, 
copy/move on a file that has been checked out. Even when another user is sharing a file, the user is 
sharing based on the version that was prior to your check out. 
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5. The version number that was created during check out will be recorded. This version is visible 
to all users. 

6. After checking in, all actions are available to all users. Any users can choose to perform any 
file actions as per normal. 

 Discard Check Out 

1. Select the file that was checked out. 
2. Click on discard check out located at the top panel. 

 

3. The version number that was created during check out will be discarded. 
4. Any users can choose to perform any file actions as per normal. All actions are available to all 

users. 
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10 Versioning 

 View Version 
 

1. Select a file. 
2. Click on Show Versions located at the top panel. 

 

 

3. A pop-window will appear. 
4. The version numbers will be displayed in descending order. 
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 Create New Version 

1. Upload a file with the same name in the same folder. 

 

2. An overwrite message notification will appear. 
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3. Click on Show Versions located at the top panel. 
4. A pop-up window will appear. 
5. The version number on the top row has increased by 0.1. 
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 Restore Version 

1. Select the file you wish to restore. 
2. Click on Show Versions located at the top panel. 
3. A pop-up window will appear. 

4. Click on the restore icon  along the respective version you wish to restore to. 

 

 

11 Sync 
When working on your documents it can be a challenge to upload/download content from EasiShare 
and/or to EasiShare constantly when there are updates at either ends. Sync feature has the 
convenience for user to add file(s)/folder(s) to sync which allows the uploading and downloading of 
updated file(s)/folder(s) on the fly. Once it is added, file(s)/folder(s) that are in your desktop will get 
updated from EasiShare in a timely manner which can be set and when users edit the file from their 
desktop upon closing, the file will be uploaded to EasiShare. 

 Add To Sync 

1. Select the file/folder. To select, click on the checkbox beside the file/folder name. You may 
select multiple files/folders at a time by clicking on multiple checkboxes. 

2. Select the Add to Sync along the Action Pane located at the top. 
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3. The pop-up below would be displayed for the user to confirm the add to sync action. 

 

4. On success, a notification and a green tick  will appear. 
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 Remove From Sync 

1. Select the file(s)/folder(s). To select, click on the checkbox beside the file(s)/folder(s) name. 
You may select multiple file(s)/folder(s) at a time by clicking on the checkbox. 

2. Select the Remove From Sync along the Action Pane located at the top. 
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3. The pop-up below would be displayed for the user to confirm the remove from sync process. 

 

 

 Sync Setting 
Sync settings allow user to set sync intervals, sync changed file(s)/folder(s) and sync the whole 
directory. 

1. Click on the File Tab located at the top. 
2. Click on Settings. 
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3. A pop-up window will appear. 
4. Click on the Sync Status icon to navigate to the Sync Status. 

 

 

11.3.1 Sync Now 

Sync Now allows users to Sync All changed files from the server to the EasiShare and vice versa. 

1. Refer to step 1 to 4 of Section 11.3 Sync Setting. 
2. Click on Sync Now. 
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11.3.2 Full Sync 

Full Sync allow user to scan and sync the whole directory for any changes that was in the server to 
EasiShare and vice versa. 

1. Refer to step 1 to 4 of Section 11.3 Sync Setting. 
2. Click on the arrow button for more options. 
3. Click on Full Sync. 

 

4. The pop-up below would be displayed for the user to confirm the perform of full sync. 
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11.3.3 Sync Interval 

Sync Interval allows users to set how frequent EasiShare check for file changes on files that were 
added to sync. Setting it to 5 minutes will allow the synced file to upload/download every 5 minutes if 
there are changes to the file. 

1. Refer to step 1 to 4 of Section 11.3 Sync Setting. 
2. On Sync Interval, click on the dropdown arrow. 
3. Select the interval in minutes. 
4. Click on Save. 
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12    Monitor 
 

You can get a notification via email whenever a file or folder is changed in your drive(s). You may see 
different options when you monitor a file or folder. 

 

  12.1   Monitor a file 
 

1. Select the file that you wish to monitor 
2. Right-click the file and select Monitor 
3. Select the options 

 
4. Click on Monitor 
5. Once successful added to Monitor, you should see a Monitor icon beside the file. 
6. You can check all Monitored files in Quick Access > Monitor 

 

    12.2   Monitor a folder 
 

1. Select the folder that you wish to monitor 

 

Option Description 

Changes > Modified When the file has been overwritten 

Changes > Deleted When the file has been deleted 

Changes > Unlocked When the file is Discard Check-Out 

Changes > Share Changed When the file was shared 

Frequency To control when you will receive an email notification 

• Immediately  
• Daily (Default: 9AM) 
• Weekly (Default: Monday) 

When Available selection: 

• Any changes 
• Someone else changes 
• Any changes to document created by me 
• Someone else changes document created by me 
• Someone else changes document last edited by me 
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2.  Right-click the folder and select Monitor 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. Select the options 
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Option Description 

Changes > New Uploads When a file is uploaded in the folder and any of its 
subfolders 

Changes > File Modified When any file has been overwritten 

Changes > File Deleted When any file has been deleted 

Changes > File Unlocked When any file is Discard Check-Out 

Changes > Share Changed When any file was shared 

Changes > Manage Changed When the folder and any of its subfolders has 
added/removed/edited managed permissions 

Note: This selection only affects folders and the 
following ‘When’ Options do not apply: 

• Any changes to document(s) created by me 
• Someone else changes document(s) created by 

me 
• Someone else changes document(s) last edited 

by me 

Frequency To control when you will receive an email notification 
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4. Click on Monitor 

   

 

 

 

 

 

 

 

 

 

 

 

 

5. Once successful added to Monitor, you should see a Monitor icon beside the folder. 

 

• Immediately 
• Daily (Default: 9AM) 
• Weekly (Default: Monday) 

When Available selection: 

• Any changes 
• Someone else changes 
• Any changes to document(s) created by me 
• Someone else changes document(s) created by 

me 
• Someone else changes document(s) last edited 

by me 
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6. You can check all Monitored files in Quick Access > Monitor 

 

 

 

 

 

 

 

 

 

 

 

12.3 Stop Monitoring a File/Folder 
 

1. Select the file/folder that you wish to stop Monitoring 

 

 

 

 

 

 

 

 

 

 

 

 

     2. Right-click the folder and select Monitor 
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       3. Click on Stop 
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13 Workflow 
 

This section shows you how to create a share approval workflow that requires everyone (all/any 
assigned approvers) to agree for a share request to be approved.  

 

This is useful in an organisation that requires sharing requests of certain documents to be approved. 

      13.1 Owner Creates Workflow 
1.  Select the file/folder that you wish to create a workflow 

                  

  

        

 

 

 

 

 

 

 

 

 

   2. Click on create workflow under Workflows tab. 
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    3. Select the approver(s) 

    4. Select “All must approve” or “Anyone can approve” 

    5. Click on Apply 
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      13.2 Owner Edits Workflow 

  1.Select the file/folder that you wish to edit a workflow 

               2. Click on edit workflow under Workflows tab.  

 

       3. Select the approver(s) 

 4. Select “All must approve” or “Anyone can approve” 

       5. Click on Apply 
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12.3 User Checks Pending Approvals and Remind Approvers 
 

1. User shares a file/folder as per Share section. 
Note: A Share Approval Workflow appears if a Workflow was created. Click on Yes. 

 

2. To check on Shares pending for approval, click on Shared > Pending 
3. To send a reminder, select a pending Share. 
4. Click on Send Reminder on the top left. 
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12.4 Approvers Approve or Reject with Comments 
 

1. To review a Share Request, navigate to the Workflow tab. 
2. Click on Review Share Request. 

 

3. A popup window will appear, select a file/folder. 
4. Select Approve or Reject. 
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5. If Reject was selected, enter a reason for the rejection for the user. 
6. Click on Reject. 

 

 

4
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